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Requisitos del Sistema

® Reform 12 Enterprise o Reform 12 PDC

® Plugin MOST

® Plugin MOST Bubble Sheet

® Para evaluacidon y demostracion: Windows XP, Windows 2003 Server, Windows

Vista, Windows 7 o Windows Server 2008 (se admiten los sistemas operativos de 64
bits)

® Para los sistemas de produccién: Windows Server 2003 o Windows Server 2008
(sistemas operativos de 64 bits son compatibles)

Todas las descargas de software Reform necesario pueden encontrarse en
www.fabsoft.com >> Seccion de descargas.

Requisitos de Hardware

Consulte la documentacion de Reform 12 y documentacion MOST acerca de los
requisitos de Hardware.
Other Requirements

® MOST must be configured before installing.

Instalacion
Para instalar Most-BubbleSheet su instalacidn existente de Reform 12, debe descargary
ejecutar el ejecutable de instalacion bubblesheet.ext

bubbleshest

Siga paso a paso las indicaciones hasta que comience la instalaciéon. Después de
completar la instalacion de MOST-BubbleSheet, debe reiniciar el servicio Reform
Spooler. Abrir el Spooler yendo a Start>Programs>Reform..>Spooler. Haga click en el
botdon Refresh o el botdn rojo de Detener y, a continuacion, el botén azul de Inicio.
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Reform12 Spooler, Monitor - Unicode - Unregistered Yersion

File Action Log Help

09 @y o
Forms Process Results
Form Mame Description SEC...
Start Service accaunt: Metwork Service

El directorio de instalacién predeterminado para Reform 12 y sus plugins es C:\Program
Files\Reform...\. Si ha cambiado la ruta durante la rutina de instalacion Reform o si
utiliza un sistema operativo de 64 bits, consulte la ruta adecuada en lugar de la
predeterminada al que hace referencia a lo largo de esta documentacién.

Importando Pantalla Most
Por favor consulte el manual MOST para obtener mas informacion sobre la terminologia
Most, Configuracién Most y prueba de Conexién.

Para importar la pantalla MOST que puedes utilizar con BubbleSheet ir a Start>
Programs> Reform...> Bubble_Sheet>Install Bubble Sheet for MOST

r‘j Manager 5% Microsoft Update f@ EBubble_shest *| B Instal Bubble Shest For MOST
-.lj ACcessories 4 -Jﬂ MOST 4 ser Manual
{‘j MOST Deskhop -Jj Skartup » E Diesigner
5oL S - & TIntermet Explorer Inskall Windows Printer
erver Cor —
% Manager ﬂ LogMeIn | Spodler
'5] Cutlook Express User Manual Printable PDF
. PRemate Assistance @ Lser Manual Searchable
-Jj Microsoft SCL Server 2005k ‘Wideo Training Center
All Pragrams B Ricoh_Reform_PDC_wi2 2 WarkFlow Designer

Si no estd abierto, aparecerd el MOST Designer y se le pedira que importe las pantallas.
Haga click en Yes.
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Import |

\?,/ Impork Bubble_Sheet into MOST?

Dejar el MOST Designer abierto ya que lo vamos a utilizar.

Asignando Coleccion a Usuarios
1. Si el MOST Designer no esta abierto aun, ir a Start> Programs> Reform...>
MOST>Designer
2. En la barra de herramientas MOST Designer haga click en Data>Users and
Groups
3. En Usuarios, haga click en demo (el Usuario demo se utiliza para el tutorial, pero
puede anadir esta coleccidn a cualquier usuario). Seleccionar BubbleSheet de la

coleccién disponible y haga click en para agregar a la coleccién de

BubbleSheet. Ir a File> Haga click en Guardar o haga click en el icono = en la
barra de herramientas.

@ MosT Designer !EE

File Edt “iew Data Tools ‘Window  Help

21| Users and Groups™ [/ |G\obal\r"ariab\es XI

¥ Advanced Seaich

T:Save '_Fo File

§ — Users/Groups [~ Settings T_SaveToFile_Status
» Edit Data R GA
El - Login Timeout: IU 3: Scan Mode: IAuto Feeder 'I Emai
mai
b Log Out E| Colar: W Sides: | Ore Sided 4 le_Shest_AddTester
‘. Domain Users le_Sheet_EditT ester
¥ Preview Compression: | MMR b Filz Type: ITIFF 'I l=_Sheet_RemoveTester
) T_Email
¥ Process Dienaity: IDelauIl 'l Scan Type: IMixed 'I T_Email2
- . T_Email_Status
» Process Al iecotion |3UU di j' Size: IAU[U jv IT_EmailBubbleSheet
T_LDAP_Emai
P Process Data = Calleslts T;ILDAFLEma\I.Z -
4 | »
» Pull Data Awailable Collections: Selected Collections: e |

el outbeshes )
¥ Reset Data Email Uszers and Groups -

Scan To Folder
» Save To Global
» Smatt Search
= Kl

¥ CheckBox

} Enable/Dizable Add Remove | £ | hd

- ComboBox Objects

¥ ComboBox

Configurando Email
Ir a Start>Programs>Reform>MOST>Designer y vaya a Data>Global Variables...
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& mMosT Designer

File  Edit  Wiew | Data | Tools  Window  Help

AE ..‘z‘ -ii IUzers and Groups. ..
- Button Dbjects Collections. ..
b Advanced Search | Global Yariables.. .
Skatic Data, ..
e Display Properties. ..
b Log Out Proimity Card Data. .
m

Asegurese de rellenar las variables de correo electrénico con la informacién correcta.
Puede que deba completar todos los campos si lo requiere la configuracion de su correo
electrdnico.

lobal Warables™ (% |
— Global Y ariables

Encrypt | ‘W ariable | W alue |
O CommunicationT ppe Local
O EmailServer ame “'ourEmailServert ame
O EmailSerserT ype SMTP
O EmailT oS el True
O E il zert ame
EmailllzerPasswiord
O Exchangedlias

Tutorial MOST BubbleSheet

En este punto, debe tener un conocimiento basico de la funcionalidad de MOST. En este
tutorial, vamos a utilizar MOST Desktop para simular un MFP ejecutando MOST vy
conectandose a un servidor MOST. Este tutorial asume que la conectividad MOST vya se
ha configurado y establecido. (EI MFP necesario para probar la funcionalidad de
impresion de estado de este tutorial. Consulte el manual MOST acerca de coémo
configurar MOST en el MFP o cualquier otra cuestion MOST.)

El emulador muestra exactamente lo que se ve en un MFP y funciona de la misma
manera. Este mismo proceso podria ser probado con los mismos pasos, pero al instalar
MOST en el MFP siguiendo las instrucciones en el manual MOST.

1. Ingresar a MOST en un MFP o use MOST Desktop (Start > Program >
Reform...>MOST>Misc>MOST Desktop) utilizando el nombre de usuario vy
contrasefia para el cual dio la coleccién BubbleSheet. En el tutorial,
configuramos el usuario demo, contrasefia demo. Haga click en Log In.
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M mosT [_[o]x]
File

form

Reform Your Business Platform

Uzername: | demo

Pazzword: |tk Log In

B2009 FabSoft w2, 3.91112.628

2. El emulador ahora se conectara al servidor MOST e inicie la sesiéon. Una vez que
inicia la sesidn, vera una serie de colecciones y pestafias. Para este tutorial,
vamos a usar la coleccion u pestaiias BubbleSheet que se han hecho disponibles
para el usuario.

I B3
File
Bubb|eSheet
Imprimir hojas de burbuja
Imprimir Prueba
Resultados Nimero de estudiantes

Azregar Examiv..

Buscar Mombre de Clase
Borrar Examin.. .

Buzcar Descripcion de Clase
bzrezar Claze
Editar Clage Buscar Ubicacidn de Clase
Escaneo #30lo claszes con estudiantes seran mostradas.
Mombre de la Prueba:
aCErFBFSEsion Inerimir hojas de prueba
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3. De la coleccién de BubbleSheet aparece la pantalla de prueba de impresién que
permite imprimir documentos. Lo primero que queremos hacer es ir a la pestaia
Agregar Clase. A laizquierda, haga click en la pestafa Agregar Clase y rellene los

campos con la siguiente informacion:
Nombre Instructor: Luna Cruz
Nombre Clase: 2™ Grade

Descripcion Clase: 2" Grade
Ubicacién Clase: Room 202

Haga click en Guardar para agregar la Clase.

& MosT
File

Bubb | eSheet

Imprimir Prueba

= B3

Mombre Instructor: ‘
fzregar Exami...

Borrar Examin. .. Mombre de |a Clase: ‘

teregar Clase Descripcion de |la Clase: ‘

Editar Clase Uhicacién de |la Clase: ‘

Escanen

aCerrarSesion Reiniciar

Hﬁunnnnn

Después de hacer click en Guardar, queremos afiadir un Examinador a la clase que
hemos creado. Escriba el nombre del verificador y haga click en la clase a la cual desea

agregar. Aiadir el siguiente Examinante:

Nombre del Examinador: John Doe

Haga click en Guardar para afiadir el Examinante.
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EMosT
File

Imprinir Proeba

hzregar Exami...

Borrar Examin...

fzregzar Claze

Editar Clase

Ezcanen

BubbleSheet

Mombre Examinante:

Clasze:

S[E 3

Nombre Clase

Descripocidn Clase

aCerrarSesion

Reinicar

H GUARDAR

Después de hacer click en Guardar, queremos afadir otro Examinante a la misma clase.
Afadir el siguiente Examinante:

Nombre del Examinante: Jane Doe

Haga click en Guardar para afiadir el Examinante.

= MosT
File

Imprimir Prueba

herezar Exami...

Borrar Examin...

hgregar Clase

Editar Clase

Escanen

Bubb | eSheet

Nombre Examirante:

Clase:

= B3

Mombre Clage

2nd Grade

Descripocidn Clase

nd Grade

a Cerrariesion

Reinicar

H GUARDAR
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4. A la izquierda, haga clic en la pestafa Imprimir Prueba. Haga click en Buscar
Nombre de Clase y deje el campo vacio para devolver todas las clases. Sélo debe
ver 1 entrada de la lista porque los 2 examinadores de las pruebas que hemos
anadido en la misma clase, que es 2" Grade.

& MosT
File

Imprimir Prueba

hzregar Exami...

Borrar Examin...

fzrezar Clase

Bubb | eSheet.

Imprimir hojas de burbuja

Buscar Nombre de Clase

Buscar Descripcidn de Clase

Editar Clase

Buscar Ubicacidn de Claze

Ezcaneo

Mombre de la Prueba:

aCerrarSesion

Resultados

?rd Grade

[ B

Himero de estudiantes

#80lo clases con estudiantes seran mostradas.

Imerimir hojas de prueha

Queremos afadir otra clase. A la izquierda, haga click en la pestafia Agregar Clase

rellene los campos con la informacién siguiente:
Nombre Instructor: Luna Cruz
Nombre Clase: 3" Grade
Descripcién Clase: 3™ Grade
Ubicacién Clase: Room 303

Haga click en Guardar para agregar la clase.

= MosT
File

Imprimir Prueba

hzregar Exami...

Eorrar Examin...

hzregar Claze

Editar Claze

Escaneo

EubbleSheet

IS[E E3

Mombre Instructor: | Luna Cruz

Mombre de la Clase: |3rd Grade

Descripcidn de la Clase: |3rd Grade

bicacién de la Clase: | Room 303

a Cerrariesion

Reiniciar

Huunnunn
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Después de hacer clic en Guardar, queremos afiadir un Examinante a la clase 3" Grade.
Afadir el siguiente Examinante:

Nombre del Examinante: Jenna Doe

Haga click en Guardar para anadir el examinante.
= MosT 9= B3

Bubb | eSheet

File

Imprimir Prusba

hzrezar Exami. .. Mombre Examinante: |Jenna Doe
Nombre Clase Descripocion Clase
Borrar Examin.. .
Clage: 2nd Grade 2nd Grade

3rd Grade 3rd Grade

fzregar Clase

Editar Clase

Escaneo

aCerrarSesion Reinicar HGUARDAR

5. Alaizquierda, haga clic en la pestafia Editar Clase. Haga clic en el botén Clase y
deje el campo vacio para devolver todas las clases.

= MosT M= B3
File
Bubb| eSheet.
Escriba el nombre de la clase, descripcidn
Buscar Clases: Clase o o e b (s
Imprimir Prueba 0 ubicacion como la palabra de DUsqueda.
L Evani Inst ructor Hombre Clase Descripoidn Clase Ubicacion Clase
ZFegar Examl...
Luna Cruz 2nd Grade 2nd Grade Room 202
. Luna Cruz 3rd Grade 3rd Grade Room 303
Borrar Examin...
hzrezar Clase
Editar Clasze
Escaneo
Inst ructor: Hombre Clase:
Clase Desc: ‘ ‘ Clase Ubi: ‘ ‘
aCErrarSesiDn Reiniciar Guardar
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6. Seleccione Luna Cruz, 3™ Grade de la lista para editar su informacién y haga click
en Guardar cuando termine. Haga click en el botén clase para actualizar la lista y
deberia ver la nueva informacion.

Nombre del Instructor: Luna Cross
Nombre Clase: 4™ Grade
Descripcion Clase: 4™ Grade

Ubicacion Clase: Room 204

EMosT [HIE E3
File

Bubb | 25hest

Escriba el nombre de la clase, descripcidn
Buscar Clases: Clase N )
Inprinmir Frushe 0 ubicacion como la palabra de bisgueda
" Evemi Inst ructor Nombre Clase Descripeidn Clase Ubicacidn Clase
ZFEZAr EXaml. ..
Luna Cruz 2rd Grade ?nd Grade Room 202
. Luna Cross 4th Grade 4th Grade Room 204 |
Borrar Examin...
Editar Clase
Escaneo
Inst ructor: Nombre Clase:
Clase Desc: | | Claze Ubi: | |
aCerrarSeleﬂ Reiniciar Guardar

7. Volver a la pestana Imprimir Prueba y haga click en el Buscar Nombre de Clase y
deje el campo vacio para devolver todas las clases. Verd las 2 entradas.
Seleccione 2" Grade de la lista.

B MosT IS E3
File

Bubb | eSheet

Imprimir hojas de burbuja
Inprimir Prusba
Resultados Nimero de estudiantes
hzregar Exami... - = .
Buscar Mombre de Clase
4th Grade 1
HHIIHIIHHHHIHIII
Buscar Descripeidn de Glase
hgregar Clase
Editar Clase Buzcar Ubicacion de Clase
#Z0lo clages con estudiantes seran mostradas.
Mombre de la Prueba: | ‘
aCe""af’SesiDn Imprimir hojas de prueba
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8. Un MFP tiene que imprimir las hojas de prueba. Escriba el Nombre de la Prueba
y haga click en el botén Imprimir Hojas de Prueba. El nimero de hojas de prueba
impresas dependerd del nimero de estudiantes en la clase y una copia para el
instructor.

EmosT o=
File

BubbleSheet

Imprimir hojas de burbuja

Inprimir Prusba
Resultados Mimero de estudiantes
Azregar Exami... rd Grade ‘
Buscar Mombre de Clase nd Grade
4th Grade 1
Borrar Examin.. .
Buscar Descripcidn de Clase
hzregar Clase
Editar Claze Buscar Ubicacion de Claze
Ezcaneo #30lo clases con estudiantes seran mostradas.

Mombre de la Prueba: |2nd Grade Test |

aCerrarSesion Imerimir hojas de prusha

9. Ahora vaya a la pestaiia Borrar Examinante, haga click en el botén Examinante
para actualizar la lista. Seleccionar Jane Doe para borrar. Haga click en el botén
Eliminar para borrar Jane Doe de la lista.

= MosT =[O x|
File

Bubb | eSheet.

Blisaueda de

Nomre de la Clase Fotud anfes:

Imprimir Prueba

Jerra Doe 4th Grade Examinarte

Johr Doe 2nd Grade

hzregar Exami...

Borrar Examin... . )
Dejar la blsqueda

en blanco para |istar
todos los estudiantes.

hgregar Clase

Editar Claze

Escaneo

aCerrarSesion Eliminar
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Espere unos segundos y haga click en Examinante para actualizar la lista. Podra
ver que Jane Doe se elimind de la lista.

EMosT H= B3
File

Bubb leSheet
Hombre Mombre de la Clase Blsqueda de

Imprimir Prusba Jerna Doe 4th Grade Estudiantes:

John Doe 2nd Grade Examinante
hzregar Exami...

Borrar Examin... .
Dejar la blsqueda

en blanco para |istar
berezar Clase todos los estudiantes.

Editar Clase

Escanen

aCerrarSesion Eliminar

10. Ir a la pestafia Escaneo cuando las pruebas se completan y haga clic en el botén
Escanear.

I B

File

BubbleSheet

Imprimir Pruesba

Prusbas completas de Escareo con cédizos de barras Tasloc

hzrezar Exami...

Borrar Examin... Orientacidn de Pdsinas: buto ‘ - ‘

brrezar Clase

Editar Clase

Ezcanen

aCerrarSesion Escanear
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11. Haga click en el botdn Cerrar Sesidn para terminar el tutorial.

= MosT S= B3
File

Bubble3heet

Imprimir Prueba
Pruebas completas de Escareo con cédizos de barras Tagloc
hzregar Exami...
Borrar Examin... Orientacidn de Pazinas: buto ‘ v ‘
hzregar Clase
Editar Clasze
Escaneo
aCerrarSesion Escarear
Mantenimiento

Hay ciertos directorios y tablas SQL que deben controlarse para crecimiento, junto con
el Ricoh BubbleSheet para Reform 12. Cada vez que un sistema procesa mds y mas
empleos, el tamafio de estos directorios y tablas SQL puede crecer muy rdpidamente. En
general el rendimiento del sistema puede verse afectado por la gran cantidad de
espacio que pueden ocupar los archivos. Ademas, existe un limite de base de datos de 4
GB si utiliza Microsoft SQL Server Express 2005 suministrado con la instalacién. Entradas
obsoletas archivos/base de datos se deben eliminar de acuerdo a sus necesidades y
especificaciones de retencidn de archivos. Se recomienda monitorear el crecimiento de
los siguientes directorios y tablas SQL:

Directorios:
C:\Program Files\Reform...\Backups
C:\Program Files\Reform...\Spooler\ImageQueue

Tablas SQL:
Reform_BubbleSheet_Groups
Reform_BubbleSheet_Students

Otros nombres de empresas o productos mencionados en este documento pueden ser
marcas comerciales o marcas registradas de sus respectivas empresas
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